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BSD SPECLINK®: THE NEXT GENERATION

For the last couple of quarters we have been
reviewing SpecLink-E (just E for short),
BSD’snext generation SpecLink software.
After morethan 10 years developing,
fielding, and supporting the SpecLink+
system, we have many reasons for develop-
ing anew “platform” from the ground up. If
you haven’t read the LinkLine issues of the
past two quarters you might want to visit
http://www.bsdsoftlink.com/linkline/current/
linkLine_archives.htmto read the Summer
and Fall Next Generation articlesfor more
info onthisimportant BSD initiative. These
articles discuss the rationale behind this
initiative and BSD’smost important goalsin
embarking on this development effort. They
also discuss the new user interface, new
installation and updating technologies, and
E’s connected and disconnected operation
inanetwork environment.
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PART III

In this quarter’s newsl etter we want to
discuss the ins and outs of developing
interoperability between applications. BSD
iscurrently developing software, referred to
asLinkMan-E (or LME), to support “link-
ing” SpecLink-Etomultiple CAD environ-
mentsin away that recommends or, option-
ally, actually enables specification sections
and individual paragraphsfor inclusionin
the project specifications as the CAD model
isdeveloped. In addition, LME isintended
tofacilitate“linking” between BSD’s
CostLink/AE (AE) cost estimating system,
the CAD environments, and SpecLink-Ein
such away that AE is able to use quantities
generated by the CAD environment, and the
cost estimate elements can recommend or,
optionally, enable SpecLink-E sectionsand
paragraphs. If these relationships sound
complicated, their implementation—ina
meaningful way — ismuch more so.

Consider thefollowing:

The building cost estimating processis
essentially one of identifying, quantifying,
and costing the erection, installation or
application of products to create the
building. The cost datathat CostLink/AE
usesis provided by RS Means, the leading
purveyor of building cost datain the United
States. An RS Means cost database “line
item” typically describes the cost to
purchase and install a product (such as
metal studs, drywall, or paint). An RS Means
“assembly,” such as those used by AE,
combinesmultiplelineitemsto create a
larger unit of construction, such asawall.
The use of assemblies makes estimating
easier and faster than working with line
itemsdirectly.

Cost data must have an organizing structure
to beuseful. RS Meanslineitem datais

See “ BSD SpecLink” on page 5
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STATISTICAL HARVEST

Building Systems Design’s BSD SpecLink® is unique in many ways. Most users are aware,
for example, that it is the only guide specification system based on arelational database.
However, most users are not aware of the fact that BSD SpecLink isthe only guide specifi-
cation system that automatically gathers information about how it is being used by its

customers.

For instance, we know that 11,655 SpecL.ink projectswere active during the period 11/1/05-
10/31/06. The most frequently used sectionis07 9005 (07900) — Joint Sealers, whichis
included in 46% of the project manuals generated with SpecLink. Thisisfollowed by
Section 09 2116 (09260) — Gypsum Board Assemblies, used in 43% of projects, and Section
09 9000 — Painting and Coating (09900 — Paints and Coatings), used in 40% of projects.

We also gather more specific information about project specifications. If we examinethe

datafor Section 09 2116 — Gypsum Board Assemblies, for example, wefind that of the 5,013
projects that used the section over a one-year period, particular gypsum board manufactur-
erswere specified about half the time. We a so know exactly how many times each manufac-

turer was specified, asfollows:
See“ Sats” on page 3




CosTLINK A/E HELPS ROTH & ASSOCIATES
PRODUCE PROFESSIONAL-LOOKING ESTIMATES

Since 1915, the Roth name
has been synonymous with
providing superior design
and construction services to
residential, commercial,
industrial, and institutional
clients.

John E. Roth started hisfirst
businessin 1915 designing
and constructing concrete
bridges in the Southeastern
Michigan area. What started
asaspecialized engineering
practice has grown into a one
stop shop for any phase of a
building project.

The Roth Companies
consists of four businesses,
each of which has strengths
that address different stages
of their clients’ projects. The
A/E, construction manage-
ment, real estate development, and consult-
ing firms can either work independently on
individual pieces or work together asa
complete solution. Either way, they share a
common history and acommon goal —
their clients’ satisfaction.

For close to 100 years, three generations of
the Roth family have been ensuring quality
design and construction projects completed
on time and within budget. Roth completed
projects can be seen throughout the
Southeastern Michigan area and Eastern
United States.

The Roth Companies have a so constructed
many high profile religious structuresin the
area, receiving awardsfromindustry
associations and organizations including
the Engineering Society of Detroit, American
Institute of Architects and Masonry
Institute of Michigan.

TheNeed: Whether it is construction
materials, drafting supplies or management
systems, The Roth Companies have always
wanted the best tools for their company

Pentastar Entrance

and their clients. Asusersof BSD's
SpecL.ink for their specification writing,

they wanted to bring that same level of ease
and professionalism to their estimating
process.

Mark Roth, President of Roth & Associates,
remarks, “We wanted to be able to prepare
an estimate of probable costs for aproject in
aprofessional-looking format. And we
needed to be able to do this no matter where
we started the project, even in the schematic
or preliminary design phase. Beforewe
started using CostLink A/E, we basically did
everything by hand. We had to look up the
information, then type up the estimate or

use a spreadsheet.” With years of experi-
ence in design, estimating and construction,
Roth & Associates recognized a good
solution when they saw it and decided to
make CostLink A/E part of their tool set.

The Solution: Roth estimatesthat by
switching to CostLink A/E, hisfirm has
achieved 40% time savings over their
previous method. In addition to time

See“ Roth” on page 3

COMPLIMENTARY

SUBSCRIPTIONS TO

SPECLINK®

BSD offers SpecLink to all educational
institutions free of charge. Over the years,
over 40 universities, colleges, and
technical schools have used SpecLink in
various curricula. Some schools have a
faculty champion and an ongoing course
offering, but most depend on a particul ar
faculty member who may or may not be
teaching the same course the next year.
What's especially interesting is that some
technical schools and community colleges
have been our most consistent subscrib-
ers. Thismay reflect the diminished
emphasisin architectural schools on
practice issues — perhaps the technical
schools arefilling that void. In any case,
any school that wishes to use SpecLink in
a course only needs to ask for a subscrip-
tion. The simplest method isfor the dean
or the instructor to send us a letter on the
school letterhead to the effect that 1)
SpecLink will be used in acertain course
for acertain term or terms, and 2) use of
SpecLink will belimited to faculty and
student use for educational purposes only.
Along with name, address, etc., that isthe
only information we require. Subscrip-
tions must be renewed on an annual basis
—if aCD isneeded, asmall shipping fee
will be charged; thereisno charge at all for
downloading from the BSD website.

In addition to serving established cur-
ricula, BSD provides SpecLink to educa-
tional and nonprofit organizations for
short term or one-time events. Recently
we provided SpecLink for the Sheet Metal
Workers International Association training
center, to use in teaching about the new
MasterFormat 2004 edition — the Master-
Format “ switch” provided avivid demon-
stration of how the new numbering
scheme relatesto the old. We welcome
inquiries from other trade and professional
associations, CSl chapters, and continuing
education providers. If youwould like us
to provide the instructors, we can do that
too — our instructor fees can be found on
our website, www.bsdsoftlink.com. [
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About Your SpecLlnk & Per Spective Updates

SPECLINK+ STATISTICS:

e 562 sectionstotal, 233 updated or new
(41%)

e 1 new non-proprietary section

e 525non-proprietary sections, 227
updated or new (43%)

e 37 proprietary sections, 6 updated
(16%)

e 46 sectionswith built-in checklists

e 94,662 paragraphs

e 102,334internal links (targetsand
consequences)

e 26,241 notesto specifier

e 15,108 noteswith live hyperlinksto
Internet web pages

e 2,119 external documentsreferenced,
with live hyperlinksto order information

e 957ASTMsreferenced, 100% verified
within last 6 months

1,162 other documentsreferenced, 72%
verified this quarter”

e 183 standards organizations referenced

e 2,397 manufacturer listings, withlive
hyperlinks to their web sites

e 934 unique manufacturerslistedin 365
non-proprietary sections

SHORT FORM SPECS STATISTICS:

e 16 sections corresponding to
MasterFormat 1995 divisions

* 6 sections updated (37%)

e 8,307 paragraphs

e 1,563 notesto specifier, 1,022 withlive
hyperlinks

e 9,045interna links (targetsand
conseguences)

e 363 externa documentsreferenced

o 224 ASTMsreferenced, 100% verified
within last 6 months

* 139 other documentsreferenced, 70%
verified this quarter”
e 43 standards organizations referenced

PERSPECTIVE PERFORMANCE SPECS
STATISTICS:

* 161 sections, 6 updated (4%)

e 17,381 paragraphs

e 21,886interna links (targetsand
conseguences)

e 4,012 notesto specifier, 920 withlive
hyperlinks
187 external documentsreferenced, with
live hyperlinksto order information

»  B0ASTMsreferenced, 100% verified
within last 6 months

e 137 other documentsreferenced, 75%
verified this quarter”

e 38 standards organizations referenced W

" Documents issued more than two years ago are verified quarterly, as are annual or semiannual publications. The documents not verified this quarter

wer e updated within the past two years.

“Roth” continued from page 2

savings, Roth has experienced several other
productivity advantages with CostLink A/E.
He says, “We now have the ability to
quickly update an estimate. And we can
easily compare the costs of alternate design
solutions.”

TheOutcome: What Roth likes best about
BSD CostLink A/E istheability to build an
estimate by combining both the assembly
costs and unit price costs — allowing him
to provide clients with a compl ete estimate
inaformat heis proud to present. |

I’ N\

“ (With CostLink A/E), we now
have the ability to quickly update
an estimate. And, we can easily
compare the costs of alternate
design solutions.”

Mark Roth
President
Roth & Associates

“Sats’ continued from page 1

For Metal Framing Materials:
Clark Steel Framing Systems. ....... 1,427times

Dietrich Metal Framing: ................ 1,559times
Marino-Ware: ........ccoceeevvevveeennenne. 1,195times
Telling INAUSEIES: ..o 383times
The Steel Network, InC. .......cccueue. 318times
Other manufacturers

entered by USEX'S: ......ccocoveveenne 88times
For Gypsum Board Materials:
G-PGypsum Corporation: ............ 2,457times
National Gypsum Company: ........ 2,469times
(U 2,534times
Other manufacturers

entered by users: ... 127times

The data tells us that fiberglass faced
gypsum board materialswere specified
on 655 projects and predecorated
gypsum board was specified on only 49
projects.

In addition to generic statistical data
about overall usage, we can gather
information about specific projects when
our subscribers permit that data transfer.

For instance, we have information about
41 projectsin Alabamaso far thisyear
that have used Section 09 2116 (09260),
whereas we have data on 43 such
projectsinlllinois, and 46 in New York.

Knowing which sections are used most
frequently and which ones are used only
occasionally allows usto assign re-
sources more efficiently for maintenance
and expansion of data. Thisinformation
will aso help us determinewhich
associations and other industry organi-
zations to pursue for assistance in
improving the specifications database.
Individual manufacturersalso may find
the data useful in determining how to
improvetheir competitive positionsin
the construction marketplace. In thefinal
analysis, improvement of our product is
our primary goal, and we believe the
moreinformation we can gather on how
BSD SpecLink isbeing used, the better
our chances will be of keeping our
customers satisfied. |
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NEw SPECLINK SECTIONS

07 5400 (07540) -
THERMOPLASTIC MEMBRANE
ROOFING:

This section covers single-ply TPO and
PV C membraneroofing and related
accessories: insulation, vapor retarder,
and ballast.

Specified applications of thermoplastic
membrane roofing includeloose-laid,
adhered, and mechanically fastened
installations.

Accessories included are base flashings,
primary flashings for roof penetrations
and interruptions, integral roofing
expansion joints, etc. Cant strips can be
included in this section or referenced
elsawhere.

Only one basic roofing system can be
specified for agiven project, but
variations of substrates, vapor retarders,
and insulations can be accommodated;
both conventional and protected
membrane applications can be specified,
provided the basic membraneisthe
same.

Virtually any type of insulation may be
specified, aswell as several types of
deck sheathing.

This section includes an optional
checklist that, based on user selections,
will automatically select and edit the
majority of text that will berequired.

FEATURED MANUFACTURER

08 7100 (08710) - Door
HARDWARE:

ASSA ABLOY Door Security Solutions
has consolidated many famous brands of
hardware into a single organization,
making it easy to get the best advice and
service on this complicated subject. For
mortiseand cylindrical locksand exit
devices, choosefrom Corbin Russwin,
Sargent, or Yale. For door closers, add
thetop-of-the-line Norton and Rixson

brands. M cKinney iswell knownfor
hinges, and now also provides floor and
wall stops, protection plates, push and
pull bars and plates, flush bolts and
coordinators, gaskets and weather-
stripping, thresholds, and awide variety
of miscellaneousitems. For electric
strikes, magnetic locks, and other
electrical controls, choose Folger Adam,
HES, or Securitron. For complete
opening coordination, choose from
hollow metal door brands CECO,
Curries, and Fleming, and flush wood
doorsfrom Graham.

ASSA ABLQY Door Security Solutions
provides independent specifiers to help
architects at no charge. According to
T.J. Gottwalt, AHC/CDC, CSl, CCPR,
MALI, Director of Architectural Develop-
ment, their “team of professional
consultants provides objective and
accurate specifications, writtenin
accordance with industry standards and
in compliancewith all local and national
building codes and regulations. The
specification consultants use their broad
range of door and security hardware
knowledge to address unique consider-
ationsin specialized market segments
such as education, healthcare, commer-
cial, and government projects.” In
addition, their factory-trained technical
support staff can provide awide array of
other services that may be useful at
many stages of the design and construc-
tion process, including:

e Design Stage: AIA/CES educational
classes; product consultation; field
hardware surveys

e Construction Documents Stage:
Code compliancereview,
specification writing

e BidStage: Pre-bid meetings

e Construction Phase: Submittal
review, job siteinspection and
installation review

e Closeout: Punchlist creation

To contact your local specification

consultant, call (800) 377-3948, or goto

www.assaabl oydss.com.

THE INDUSTRY FOUNDATION
CLASSES

BSD intends to use application
programming interfaces (APIs) to
“interoperate” with CAD system
projectsin an interactive way, keeping
the LinkMan-E interface up to date
moreor lessinreal time (see BSD
SoecLink: The Next Generation
article). When discussing interoper-
ability, we must consider the Industry
Foundation Classes (IFCs) that the
International Alliancefor Interoper-
ability (IAl) is continuing to develop.
These are a set of object definitions
that describe the building construc-
tion environment. They can be viewed
as standardized containers for
construction information. These
containers need a classification
system to be useful in passing cost
estimating and specifications data. For
example, softwarethat interprets|FCs
can identify a door object, but there is
no standard way to tell which door it
isin terms of the RS Means door
assembliesor in terms of the BSD
master specifications.

And while anumber of vendors have
implemented the meansto import and
export IFCsasflat filesthat allow
applications to “talk” in batch
transactions, none of the vendors

we' refamiliar with haveimplemented
application programming interfaces
(APIs) that allow applicationsto “talk”
to each other inreal time using IFCs.
Thislimitstheir usability when trying
toactively link and maintain a
specification and cost estimate in sync
with the CAD model asthe design,
estimate, and specification continue to
evolve. However, BSD applaudsthis
international standardization effort
and fully intends to utilize these
standards as this type of communica-
tion becomes technologically and
economically viable using mainstream
programming techniques. u
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“BSD SpecLink” continued from page 1

organized using MasterFormat, awell-known, product-oriented,
organizing structure. Today MasterFormat is transitioning from the
widely-used 1995 version, having 16 divisions (03 Concrete, 04
Masonry, 06 Metals, etc.), to the 2004 version with over 40 divi-
sions. It will take awhilefor the estimating community to cometo
gripswith the new structure and in the meantime the dual struc-
turesonly complicatethelineitemlinking
process.

RS Means assemblies data uses the Uniformat
structure (Foundations, Superstructure, Exterior
Closure, etc.), whichissignificantly more

systems that are comprised of assemblies. i‘f

When performing an assembly based cost

included in the building plans -- the estimator

[ BSD Spectink-E - Virtual Professional Building Project

: L = ﬁ Project Name
appropriate for building systems and sub- -G Division 00 - Procurement and Contracing
Division 01 - General Requirements
Facilty Construction Subgroup - Divisions
-2 Division 02 - Existing Condttions
. . PR H i+ Division 03 - Concrate
estimate -- after identifying the assemblies % ik 4 Meseany
= Division 05 - Metals

tion specification.

So how do we connect these disparate systems? BSD is presently
prototyping the LinkMan-E product. The general approach to the
problem involvesidentifying CAD objects by tagging or linking
them to CostLink/AE assemblieswhichin turn aretagged or linked
to SpecLink-E products. The LME prototype includes a navigation
tree, similar to that in Windows Explorer
or BSD’s SpecL ink product, and an
accompanying grid or table that

Broject Tree Document Window Help displays data related to the user’s

current positioning in the tree. The tree
actually supportstwo different hierar-
chies, accessed by tabs in the tree
panel, that present either a MasterFor-
mat 2004 hierarchy or aUniformat
hierarchy depending on the selected
tab.

needs to quantify each assembly. The quantities i
of theindividual products (the pricing basis) ® % Hetal ots In the current prototype, the MasterFor-
4D Metal Decking mat view includesfoldersfor each

that are included in the assembly are generated
by the formulas inherent in the assembly itself.

3D CAD systems produced by vendors such as
Autodesk, Bentley Systems, Graphisoft, and
others provide drawing tools and objects that
are most often represented in the cost estimate
as assemblies of multiple products. For example, adoor object in
CAD will berepresented by an assembly in the cost estimate that is
comprised of the door itself, the frame for the door, and the finish to
the door. A wall objectin
CAD will berepresented
by an estimate assembly
that includes metal studs,
drywall, and the taping
and finishing. Note that
the dimensions and
quantities that can be
generated by the CAD
software are those for the
assembly, not its constitu-
ent line items or products.

LinkLine

A BSD SoftLink® Publication
Editor: Niki Koplowitz

The LinkLine is published by
Building Systems Design, Inc.
3520 Piedmont Road, NE
Suite 415

Atlanta, GA 30305

Specifications, on the
other hand, deal in
products, as opposed to
assemblies, and the
properties or attributes of
those products. A specifi-
cation section generally
describes and specifies
one or more productsin
terms of their attributes.
Quantities are essentially
immaterial inthe construc-

Permission to use excerpts in
other publications is granted
provided the publisher is notified
in advance at 404-365-8900.

BSD SpecLink, BSD CostLink and
BSD SoftLink are registered
trademarks, and BSD CadLink and
BSD LinkMan are all trademarks of
Building Systems Design, Inc.

Get the latest on BSD by visiting
our web page at
www.bsdsoftlink.com

-3 Cold-Formed Metal Framing
-G Metal Fabrications
-3 Decorative Metal
i+ Division 06 - Wood, Plastics, and Con
* Division 07 - Tharmal and Moisture Pr

Master Format 2004 in SLE

specification section in the BSD Master
Specifications database. Each folder
includes entriesin the tree for each
product that is referenced in that
section. The companion grid is designed
with acolumnfor each interoperable
application: initially specifications, CAD, and cost estimating. It will
have additional columnsto display CAD quantity, cost estimate
guantity, related keynote, and potentially other information.

When the cursor is placed on a given product, the companion grid
displays the product on the first row and associated product
attributes on following rows. Thethree application columnswill
display the status of the product or attribute for that application
using avariation of the SpecLink link status display system: red,
green, yellow, checked, x-ed, and empty (in recognizable shapesfor
the color blind). The SpecLink status column will reflect the actual
SpecLink project status of the product. The CAD column will
display agreen square for each product that isindicated in an
assembly forming apart of the CAD model. Similarly, agreen
square is displayed in the cost column for each product referenced
by an assembly in use in the cost estimate. Depending on the
user’s preferences, when a CAD or cost product is added, the
corresponding product in SpecLink-E will be“recommended” (set
to yellow) or enabled (set to green). Note that the product in
SpecLink-E can have enabling linksto other related text in the
specification, optionally pre-editing the project specification based
on CAD or cost estimating selections.

The prototype Uniformat view is expected to present atree
structure including three levels of the Uniformat classification
system. As assemblies are added to either the CAD model or the
cost estimate they will be added to the Uniformat view. The

See“ BSD SpecLink” on page 7
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BSD
Software

ALL ProDuUCTS

L'] | can’t find a Save As on the menu.
How do | save the project with a
different name?

Our products are database applica-

m)  tions, which means your changes are
saved asyou are editing. You don’'t have to
save the file because the program doesit for
you. If you want to save the project with a
different name, close the project; go to the
File menu and Copy Project. You then select
the project you need to copy and when you
get to the Enter Destination File Name, give
itanew name. It will savethefilewiththe
new name. When you open thefile, you
should open the Summary Information
dialog box and make any necessary
changes. You can also start a new project
using your existing project as the project
source (in SpecLink) or asthetemplate (in
CostLink/CM and AE.) Thismethodis
generaly better because the Summary Info
Dialog Box will open automatically.

el

that?

| want to start BSD software from an
icon on my desktop. How do | do

To start any program from your

m)  desktop, you create a shortcut. To
create a shortcut open Windows Explorer
(either by right-clicking on the Start menu or
by holding down the Windows key on your
keyboard whiletyping theletter ‘E’) and size
it so that you can see your desktop in the
background. Navigate to where the software
isinstalled. The default location for
SpecLink isC:\SpecLink+, the default
location for CostLink/CM isC:\CostLink
CM, and the default location for CostLink/
AEisC:\CostLink AE. Locate the executable
file (SpecLnk+.exefor SpecLink,
CstLnkCM .exefor CostLink/CM, and
CstLnkAE.exefor CostLink/AE). With your
right mouse button, drag the executablefile
to your desktop. Release the right mouse

button when it is over the desktop and a
menu will open. From the menu, choose
Create Shortcut Here. If you created the
shortcut properly, it will havealittle arrow
on the bottom left corner. If it does not have
alittle arrow, then you moved the exe
instead of creating a shortcut. Move it back
and try again using the right mouse button
only.

SPECLINK+ AND PERSPECTIVE

Q

Thereisacatalog listing of al the

m\ sectionsin a searchable Word format

onthe CD. Itislocated in\info\SpecPlus\.
Open thefile and use Find in your word
processor to search for the section you
need. The catalog listings are aso on our
website at www.bsdsoftlink.com/speclink/
catalogs/all_catalogs.htm. You can get the
listingsin either MasterFormat 1995 or
MasterFormat 2004.

V. How do | change the formatting of
an entire section without saving a

user-defined style?
n If youwould liketo turn off the

m\  gutomatic numbering for an entire
section, first select thetext of all the
paragraphs. To do that, click to place your
cursor to the left of thefirst letter in the first
paragraph (the title paragraph) in the
section. Then hold down the Ctrl and Shift
keys on your keyboard while you press the
End key. The background of al the para-
graphs should turn black. To turn off the
numbering, from the Document menu
choose No AutoNumber.

there any options?

Q
SpecLink users should note that

m\ there are actually two tables of
contents. One is section 00010, and the
other isafully automatic table of contents
that can be printed by choosing File > Print,
then in the Reports dialog box, from the
Report to Print drop-down list choose Table
of Contents. There isacheckbox at the
bottom of the Reports dialog box which
allows you to choose whether or not you
want the page count of each section to print
on the table of contents. This table of

In SpecLink, how do | find asection
on a particular product?

| don't like the table of contents. Are

contentsisfully automatic. All active
sections, whether master sections or user-
added, will belisted. No extraformattingis
necessary.

If you are using the Table of Contents
section and it is the formatting that you do
not like, for the most part that can be
changed in SpecLink or PerSpective. You
can turn off the automatic paragraph
numbering for just the table of contents as
described in the previous question. You can
also customize the formatting to change the
spacing before and after paragraphs and the
indents of each paragraph -- from the Tools
menu choose Customize Styles and from the
Style Set dropdown list choose Block. For
information on further customizations that
can be performed using the Modify Para-
graph Format dialog box, see the updated
copy of the Printing chapter in the User
Manual onthe BSD SoftLink CD-ROM.
Once you have customized the formatting
for the table of contents, print just the table
of contents. Change the Style Set back to
what it was originally set on before you
print the other documents.

If you require formatting optionsthat are
not availablein SpecLink or PerSpective, or
if itisnot the formatting that you dislike, the
table of contents can be exported to Rich
Text Format (RTF), which can beedited in
any word processor (except WordPerfect
8.0). To export, choose File> Print and set
up the Reports dialog box as you would if
you wanted to print just the table of
contents. Then instead of clicking Print,
click Export.

:.] | have asection that looks like a
subsection. How did that happen
andhowdol fix it?

When you copy an existing section,
m\  or create anew section, the new

document becomes a subdocument to the
document or folder that you click oninthe
Tree panel prior to pasting or creating the
new section. Tofix it, you will need to move
the section. Right click on the name of the
section in the Tree panel and then choose
Cut Section. The Cut Section for Pasting
dialog box opens asking you to confirm that
itis cutting the correct section. Verify that it

Continued on next page
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Continued from previous page
isand click OK. Right click onthefolder
name in which the section should be and
choose Paste Section Into. The Paste dialog
box opens giving you the opportunity to
change the number, acronym, or name of the
document. Verify that theinformationis
correct and then click OK. The sectionis
moved to the proper location. You can also
use this procedure to renumber a section.
:.] In SpecLink, | have noticed tagsin
the T column that are not on the list

that opens from the Tags button. What are
those other tags?

Tags that are not listed on the Tags
button are used by BSD for mainte-
nance of our master database. For your
information, KW standsfor keyword, MT is
used to mark manufacturer list titles, and
UM is an obsolete tag that has been
replaced by the ML tag. For acompletelist
of tags, their uses, and where they normally
appear, see Requirements Reports either in
the online Help or in the Printing chapter in
the User Manual. For directions on using
tags, see Tagsin the online Help or in the
Creating an Office Master chapter in the

User Manual.

V.l | want to email my project to some-
one who does not have the software.

How can | do that?

You can email anindividual section,
adivision, or the entire project. To
do that, click on the File menu and then
select Print. From the Report Setup dialog
box, select Document as your Report to
Print, and select either Section, Branch or
Project asthe Scope of Report. Then click
on the Export button on the right side of the
dialog box. Select thefolder wherethefiles
should be created. You will havean RTF
(richtext format) file for each section or
chapter. These can be emailed and/or
opened in most word processors.

If you have Adobe Acrobat Writer or
Distiller installed, you can also create pdf
files. From the Report Setup dialog box,
change your default printer to Acrobat
PDFWriter or Acrobat Distiller and print as
normal. Select thefolder wherethefiles
should be created.

CosTLINK/AE AND CoSTLINK/CM

L.] Isit possible to include my
company’s logo on the reports?
y\

To insert alogo into the standard
reports, rename the logo to
logo.bmp, logo.jpg, or logo.gif, and place
that fileinto your CostLink CM (or CostLink
AE)\System\Reportsfolder. Thelogo will
automatically print in the top right corner of
your reports.

:.] What is the difference between the
Project Title and the Report Header?
n The Project Titleis entered on the
m\  General tab of the Project Summary
Info dialog box aong with an optional
project number, description, and the names

: “BSD SpecLink” continued from page 5

. Uniformat view grid will display status of

- the assembly and each of its constituent

. products in the respective application

* columns and the quantity of the assembly in

the respective application’s quantity
column. TheLME interfacewill provide

. tools and commands for aggregating,

connecting, and disconnecting CAD
quantities with respect to the CostLink/AE

* assemblies.

BSD isin the process of building lists and

. tableswithin its Master Specifications
* database that identify each product and tag

itwithauniqueD. Weareworking with

* CAD systems to determine how best to tag

. CAD assembly objects with one or more

of theArchitect, Engineer, and Estimator. All .

of thisinformation prints on the title page of
your estimate, and the Project Title also
prints in the header of each page of your
report.

The Report Header is entered in the Reports
Setup dialog box as an optional nameto
distinguish your report from other reports of
the same project. For instance, you may
print areport when the project design is
only 65% complete and you want to note
that on your printout. When you print the
final report at 100% complete, you would
change the Report Header to reflect this.

CosTLINK/CM

:.] In CostLink/CM, I’ mtrying to open

my assemblies database, and | get
Error 3045: Could not use[filepath]
Assemblies.MAS.

n If you have Access 2000 installed,
m!  your computer recognizes the

appropriate product 1Ds from our Master
database. We are also planning to similarly

* tag RS Meanslineitemswith the appropri-

. ate product 1D such that assemblies that
: includethat lineitem will also be tagged
. with the product ID.

The primary purpose of the LinkMan-E
interface isto provide a “ dashboard” that

. alowsthe project manager or other user to
. easily coordinate the project. The user

should be able to easily identify what

* productsin the CAD model have not been

. accommodated in the specifications and

what itemsareidentified in the specifica-
tions that might not be shown or used in the
model. It should readily show where cost

. estimate quantities differ from thosein the
. model, and what itemsin the specifications
- have not been included in the estimate or

. vice-versa

- Secondarily, LME should support genera-
- tion of initial specifications, either building a

Assemblies database extension (*.MAS) as .
« gpecification text, asthe CAD model and/or

an Access file. To change this, open

Windows Explorer and go to the Tools menu .
* support connecting model objects to the
. cost estimate so that as the model grows or

and choose Folder Options. Click theFile
Types tab and locate the .MAS extension.

Click onit, and then click on Delete. LI
. caly updated to reflect the change.

- We welcome feedback on our visions and

* planned implementations. Part of our

. purpose in revealing product designsin

* development isto elicit comment. Our goal,

. asalways, isto help you improve your

. productivity and the quality of your work. m

More questions?

Contact BSD Technical Support:

Toll Free: 800-266-7732
In Atlanta: 404-365-9226
Email: support@bsdsoftlink.com

recommendation or actually enabling the

cost estimate are developed. It should

changes, estimate quantities are automati-

BSD LinkLine Winter 2006




Training Schedule

TheBSD SpecLink+
Wor kshop

TheBSD SpecLink+ Workshop consists of
two one-day workshops. The first day is
devoted to learning the basics of
SpecLink+, including how to navigate
withinthe software, start anew project, edit
sections, understand how the links and
choiceswork, and how to format, print and
export the final document. It is designed
for new users. The second day isdesigned
for those who want to learn how to create
and maintain their own officemaster. This
day covers the concepts of an office mas-
ter, how to customize your master by add-
ing choices, links, and tags, aswell ascre-
ating your own checklists. Users must al-
ready be familiar with the basics of
SpecLink+ to attend the second day.

BSD SpecLink+
Either Day* $495
Both Days* $895

2006
December 5 - 6, Atlanta

2007
January 9 - 10, Atlanta
January 23 - 24, Charlotte, NC
February 20-21, Seattle
March 13 - 14, Atlanta
March 20-21, Chicago

AlIA Members: We will report your course
completion for 7 or 14 Continuing Education
Units
CSl Members: Submit Course Completion
Certificate for 7 or 14 Education Contact
Hours (ECHSs) toward your CCS, CCCA, or
CCPR Certification renewal

* Class starts at 9:00 AM and ends at 5 PM.

BSD CostLink/CM
3days* $1295

Scheduled on a demand basis.
Call 888-273-7638.

AlA Members: Submit Course Completion
Certificate for 24 Continuing Education Units
CSl Members: Submit Course Completion
Certificate for 24 Education Contact Hours
(ECHs) toward your CCS, CCCA, or CCPR
Certification renewal

* Class starts at 9:00 AM and ends at 5 PM.

View BSD class schedules on our website! Go to www.bsdsoftlink.com and click the Training link. Get directions & information on travel, hotels, & Atlanta!

PABSD

Building Systems Design, Inc.

3520 Piedmont Road, NE
Suite 415
Atlanta, GA 30305
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